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Access Database Basics 

The following course is an introduction to Microsoft Access. 
It is designed to have the student understand what Access is 
used for and give the student some hands on experience 
with some of the basic features. 

Skill Level: Intermediate/Advanced 

Requirements: Intermediate computer skills, good 
understanding of other Microsoft Office products  

Length: 2 hours 

 
During this course we will look at: 

 What is a database? 
 What is Access? 
 Defining tables 
 Understanding records 
 Creating fields 
 Creating Access elements 
 Developing tables 
 Developing forms 

By the end of the class students will have built a database of 
customers for a travel application. 
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What is a Database? 
Databases are collections of related data.  A database allows a user to store 
data in an organized manner. A database can gather information about the 
collection of data to manipulate, sort, and summarize it.  It also provides a way 
for other computer programs to quickly retrieve and update desired pieces of 
data.  Access is the database program used for this lesson. 
 
 

When should I use Access? 
Access is specifically a Relational Database Management program.  It should be 
used when someone is using multiple tables (or groups of categorized data).  
For example, a mom & pop store might collect 1) customer data (name, 
address, etc.), 2) order info, and 3) product data.  If all they wanted to do is 
send out a mailer, Excel would work just fine to store this data.  However if the 
store was also interested in things like recording each customer order and item 
information, seeing what the bestselling items are, or in what zip code their 
sales are highest, they would want to use Access instead.   
   
 

Starting a Database 
This class will concentrate on some of the basics of using Access.  We will 
explore the key terms and features that a beginner should be familiar with in 
Access.  We will create a simple table, a form to populate the table, and a 
report to display information from the table.  

Open Microsoft Access by double clicking on the Access icon on the desktop. 

To open a new database, click once on the Blank Database Icon then click on 
the Create button near the bottom right of the screen (you can name your 
database at this point too). 

A new database will open and the beginning of your first table will appear in 
what is called Datasheet View.  This will look very similar to an Excel 
spreadsheet.  
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Microsoft Access Layout 
Ribbon - Located above the database at the top of the page, the Ribbon 
contains all of the commands that you can carry out in Access.  

 

Tabs – Additional tools are exposed across the Ribbon based on which tab you 
have selected, “Home”, “Create”, “External Data”, “Database Tools”. 
 
 

Tables 
A table is a list of related information collected in columns and rows. For 
example, a customer’s basic information can be kept in a table. 
 
From here we can start building our table.  Tables consist of fields and records.  
First we create fields (columns), and then we can populate the records (rows) 
with relevant data.  

To create fields in a table: The ID field will automatically be created.  The ID 
field allows for each record to have its own unique number.  You will see this 
when we add records.  

To add a field: Double Click on the words Add New Field and then type in the 
field name. Hit enter or tab on your keyboard to name more fields.   

Practice: Enter fields for First Name, Last Name, Address, City, State, Zip, and 
Telephone. If you make any mistakes, you can edit the field names once you 
see a cursor. If you don’t see your cursor, double click on the field name until it 
has a black background. Then, click to insert your cursor to correct your error 
or press the Backspace key to clear that field name. 
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You have just created the base for your first table!  We have to save and name 
our table.  We can do this by right-clicking on the tab above the field names 
(currently Table1), clicking SAVE, typing “Customers”, and clicking OK. 
 
 

Records and Fields 
In a table, each row is called a Record and each column is called a Field. This is 
an example of a Customer Table: 
 

 

Pretend that you run a travel agency. In addition to the table with the 
customer information, we will build a table with registration information and 
another with trip information.  

Access is called a Relational Database because the tables can all be linked 
together, or related, to help you make the most out of your data, as you can 
see in the image below. 

In this example, the ID field in the Customers table is linked to the Customer ID 
field in the Registration table. The Trip ID field in the Registration table is linked 
to the ID field in the Trips table. 

 

Record 
Field 



 
 
 

 
 

 

 
 

Public Computer Center, Version 1.1 Page 6 of 26 
* All instruction based on Windows 7 Operating System 

By using Access, our travel agency is able to extract the number of people from 
a certain zip code that registered for a trip, determine how much a customer 
travels, or find out whether or not customers have paid for their trip(s). You 
can do this by creating Queries.  Although queries are not covered in this 
lesson, be aware that they are a powerful way of extracting information from a 
database. 
 
Defining Field Properties  
Since clients of our travel agency reside in New York State, we can instruct 
Access to automatically fill NY under the State field for all of our entries (or 
records). We can also set the format of each field. For instance, with our 
telephone field, instead of typing the parentheses around the area code and 
typing a dash in between the third and fourth number, we can use something 
called an input mask to do that for us. 

The first step is to go to Design View, which is located in the Datasheet tab. 

 

Next, click on the State field and type NY next to Default Value under Field 
Properties. 
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Then click Telephone. Make sure the Data Type is Text. 

 

Click the   button next to Input Mask. (If you see a pop-up about saving your 
table, click Yes.) You should then see an Input Mask Wizard pop-up box. Leave 
the selection on Phone Number and click Finish. 

 



 
 
 

 
 

 

 
 

Public Computer Center, Version 1.1 Page 8 of 26 
* All instruction based on Windows 7 Operating System 

Return to Datasheet View by going to the Design tab and clicking the arrow 
under View. Choose Datasheet view and be sure to click Yes to save the table. 

Now we can start entering information in our table. You can add records in the 
datasheet view, but it is easier and more common to do this using a Form. To 
see the difference, enter the first three records in this datasheet. We’ll enter 
the rest in a form. 
 
NOTE: *If you delete a record, that ID can’t be used again.  
 
 

Creating a Form 
Click on the Create tab in the Ribbon and then click in the Form icon. 

 

You will notice two things: 
1. A form has automatically been created. Right-click the tab to Save it. 
2. The table you created is now listed on the left pane. 
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In the upper left corner of the ribbon click the drop down arrow under the 
VIEW icon and select “Form View”.  You are now in form entry mode where it is 
easy to enter records.  The fields are clearly listed.  Every time you enter a 
record, Access will automatically update the database.  In other words you do 
not need to worry about clicking on the save button every time you enter a 
record.  To enter a new record just look toward the bottom of the page for the 
small yellow STAR and click on it. You can also press Enter or Tab to create a 
new record.  

 

The fields on your screen will be blank. Enter in a new record now. Practice 
typing in the information for the remaining customers. 

 

To switch between tables and forms, double click on the appropriate link in the 
pane on the left hand side of your screen.  If you double click on Customer 
table, then click on Refresh All, it will add the records created in Form View. 

 

 
Once you have entered in the information for tables, you can create Reports 
about the information in the database. 
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Creating a Report 
From the Create tab click on the Report Wizard button.  A screen will pop up 
that allows you to pick fields from multiple tables to include in your report.  In 
our case, we want to choose from the Customers table. 

Let’s create a very basic 
report.  From the 
Customers table we 
created listed in the 
Tables/Queries list we can 
choose the First Name, 
Address, and Zip.  This is 
done by clicking on these 
fields in the Available 
Fields column and moving 
them to the Selected Fields 
column by clicking on the 
arrow (>) between the 
columns.   

                          

Then click Next.  Continue to click Next until you see the option that asks “How 
would you like to layout your report?”  Click on the radio buttons next to 
Columnar and Portrait then click Next.   

 

Next pick the style of 
the report.   
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Pick ‘Equity’ by 
clicking on it then 
click Finish. 

A report will be 
created containing 
the fields that were 
included. 

 

 

Creating Labels 
Double click the Customers table to open it. From the Create tab click on the 
Labels button (in the Reports Group).  A screen (Label Wizard) will pop up.   

The first step is to 
select the correct 
label size. You can 
filter by 
manufacturer to 
limit the varieties 
available. You may 
need to refer to 
the packaging to 
identify the 
product number, 
dimensions, and 
number across. 
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Select the Unit of Measure and Label Type. English and Sheet labels are the 
defaults. 

Once you have everything the way you want, click Next. 

You can change the font and color of the text by selecting a new font, font 

weight, or size from drop-down menu. Click   to change font color. On the 
left hand side of the pop-up window, you’ll see a sample, or preview of the 
text. Click Next. 

At this point, 
you will select 
the fields that 
you want to 
appear in the 
label. Once the 
field is 
highlighted, 
click the arrow 
to move them 
into the 
Prototype label 
box. The order 
is important. 

You can input one field after the next, but be sure to press the Space Bar key 
between items and the Enter key if the field should appear in a new line.  

If a comma should appear between two fields, use your keyboard to add a 
comma to the label. Click Next. 

 

 

 

 
 
 
 
 
 

 

You can sort your 
labels by one or 
more fields. Click         

         to add one 
field at a time. 
Click          to add 
all fields.  

 

To remove a field 
click         . Click        

         to remove all 
fields. 

 

When you are 
ready, click Next 
to name, preview, 
or modify your 
label. Otherwise, 
click Finish. 

 

 

 

 
 

You can sort your 
labels by one or 
more fields. Click 

 to add one 
field at a time. 

Click   to add 
all fields.  

 

To remove a field 

click . Click 

 to remove all 

fields. click Next 

to name, 
preview, or 
modify your 
label. 
Otherwise, 
click Finish. 
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Create the Trips Table 
To take full advantage of Access as a data management tool, we need to 
establish relationships between tables. This is called linking. Before we can do 
this, we are going to create two additional tables, the first being the Trips 
table. 

As a travel company, we plan trips to many destinations. The trips cost 
different amounts and the duration and dates of these trips vary. We will build 
a table to describe these trips. 

 

 

 

 

 Now we’ll add some additional elements. 

Add Field Names:  Double-click on the ID field and type Trip ID. Then double-
click on Add a New Field and type Destination. Press your tab key to move to 
the right. Add the following field names: Destination Details, Departure Date, 
Return Date, and Cost Per Person.  

Adjust Column Width: Some of the field names may not display 
completely. To adjust the column width, bring your mouse 
between the field names right on top of the line that separates the 
columns. Your mouse will look like this >>>>>>>>>>>>>>>>>>>>>>> 

Once you see this kind of arrow, you can adjust the width in two ways: 
1. Click and drag the column over until you can see all of the text. 
2. Double-click and Access will automatically adjust the width for you. 

 

 

 
 
 

Go to the Create tab and click 
Table. It is on the left hand 
side of the page in the Tables 
group. 

You should see a blank table 
in the middle of your screen.  

We will name and save it 
later. 
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Set Data Types for Fields: Switch from 
Datasheet View to Design View. In the 
Datasheet tab and Views group, click View. 
Select Design View. 
 

 

 

 

 

 

 

 

 

Next to Destination Details, click on the arrow to the right of the word Text and 

select Memo from the drop down. 

 

 

 

Next to Departure Date and Return Date, select Date/Time. Next to Cost, select 

Currency.  

 

 

 

 

You will then be 

prompted to name and 

save the table.  

Name it Trips and click 

OK. 

 

NOTE: You can adjust the data type in Datasheet view. Click on the field name 

(header). In the Datasheet tab, select the data type from the drop down list 

next to Data Type. 
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Add information to Table: Return to Datasheet View. In the Design tab, click 

on View and select Datasheet View. Save the table by clicking Yes. 

 

 

 

 

 

The Trip ID will be filled in automatically. If you delete a row, or record, that 

number will also be deleted and cannot be reused. 

Press tab to advance to the next cell. Enter the following information in the 

table: 

 

NOTE: You may have to adjust the column width again to see your entries. 

 

Create the Registration Table 
Go to the Create tab and click on Table in the Tables group.  
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Name the table Registration and click OK to save it. 

Now you will be entering the names of your fields. Type “Registration ID” in the 

ID field. Notice that this table will include both of the ID fields from our two 

other tables, Customers and Trips. The field names are repeated so that they 

can be linked. All of our tables will be connected so that we can better collect 

and analyze information. In our example, we will be able to monitor trip 

registration and determine which customers paid for their trips. 

Replicate the fields and data types shown below in your database. 

 

Right click on the Registration tab and click Save. 

 

Create Relationships 
The ability to create relationships is the main distinction between Access and 

Excel. We will be linking our tables by going to the Database Tools tab. Begin by 

clicking the Relationships button. 

In the Datasheet tab, click 

on View and then click 

Design View. 
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The following pop up will appear asking which tables you would like to appear 

in the Relationships window, known as the Relationship Map. We want all 

three to appear. To do this, click 

Customers and press the Shift key. 

While your Shift key is pressed, click 

Trips. This will select all three tables.  

Click Add.  Then click Close.  

 

 

 

Keys 

Tables are linked by using 

primary and foreign keys. 

Primary keys are the first fields 

in each table, while foreign keys 

are fields that appear as primary 

keys in different tables. 
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Relationship Map 

To expand the Customers box, click and drag the bottom of the box. 

We are going to establish a relationship between the Customers and 

Registration tables. It is as simple as dragging and dropping a field name from 

one table to another. 

Click on Customer ID in the Customers Table (the primary key) and drag it over 

the Customer ID field (a foreign key) in the Registration Table.  

 

An “Edit Relationships” pop up box will 

appear. Double-check to make sure that 

Customer ID is shown twice. Then click 

Create. 

 

Next we are going to establish a relationship between the Registration and 

Trips Tables.  

Click on Trip ID in the Registration Table (a foreign key) and drag it over the 

Trip ID field (the primary key) in the Trips Table. An Edit Relationships pop up 

box will appear. Double-check to make sure that Trip ID is shown twice. Then 

click Create. 

Your screen 

should look 

like this: 
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Create a Registration Form 
Close all of your tables. Tables must be closed to view the form in Form or 

Layout View. Go to the Create tab. In the Forms group, click on More Forms 

and then Form Wizard.  

 

The first step is to select the fields you want to include in your form. We will be 

selecting fields from all three Tables. 

Begin by selecting the 

Registration Table in the 

drop down. 

Use the  button to 

add the following:  

 Registration ID 

 Registration date 

 Customer ID 

 Trip ID 
 

 

Next, select the Customers Table from the drop down menu. Add First Name, 

Last Name, Address, City, State, Zip, and Telephone as Selected Fields. 

Then select fields from the Trips Table. The fields are Destination, Destination 

Details, Departure Date, Return Date, and Cost per Person. 

Go back to the Registration Table and add Paid in Full. 
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 Click Next to view your data by Registration.  

 Click Next. Leave the layout as Columnar. 

 Click Next. Choose Northwind as the style. 

 Click Next. The title of the form should be Registration.  

 Click Finish.  

 

Adjusting the Layout of the Form 
This is a glimpse of how our form looks in Form View: 

 

 

Some of the field names are cut off, so we are going to adjust them in Layout 
View. There are three ways to change the view in Access: 

1. In the Home tab, click on View and then Layout View. (We used this 
method earlier in class to get to Design View.) 

2. Right click either on the form name or form tab and select Layout View 
from the list of options.   

3. Click on the Layout View icon, or picture, in the 
bottom right hand corner of your window. 

 

 

To adjust the size of the fields, click on the box next to the word Registration 
(Registration ID) at the top left hand side of your page. The box should now be 
outlined in yellow. 

Next, bring your mouse over the left hand edge of the box and until it looks like 
a two way horizontal arrow.  

Click and drag to the right until you can read all of the field names. Since Cost 
Per Person is not fully viewable, repeat these steps on the right hand side of 
the page. 
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At this point, you can change the font size, style, color, and background color in 
the Format tab by selecting the text you want to alter. If you wanted, you could 
even add a logo to the form. It’s in the Controls group.  
 
 

Record Trip Registrations 
Return to Form View. We need to record which customers are going on which 
trips, and whether or not they’ve paid for the trips they’ve booked. We have 7 
customers and 2 trips and some customers are going on more than one trip.  

 
We are on the first blank 
record. Click on the 
calendar to the right of the 
Registration Date field and 
select a date.  
If you want, you can use 
today’s date.  

Now we’ll see how our form pulls data from the tables we created.  

 Next to Customer ID, type 1. The information for the customer with the 
Customer ID 1 is automatically added to this record.  

 Next to Trip ID, type 1. The information for trip with the Trip ID 1 is also 
populated.  

 In the field Paid in Full, type Yes. 

 Advance to the next record by clicking 
the star.   

We’re going to use our registration form to fill in the following information 
(you should have 9 records at the end):  

Customer ID Trip ID Paid in full 

1 1 Yes 
1 2 No 
2 2 No 
3 2 No 
4 1 No 
5 1 Yes 
5 2 Yes 
6 2 No 
7 2 No 
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If we were using this database on the job, we would fill the registration forms 
out as the customers register and could return to the form later to make 
changes or updates. 

 

Creating Queries and Reports 
Query 1: Trips - We want to see the names and quantities of people who are 
going on each trip. 

Go to the Create Tab  Other Group  Query Wizard 

A New Query dialogue box appears. If it is not 
already selected, choose Simple Query Wizard 
and click OK. 

 

Now we have to 
decide what 
information we 
want our query to 
contain. Specifically, 
we want to know 
the names of the 
trips and the names 
of the registrants. 

 

 

To begin, choose the Trips Table from the drop down. Select Destination. 

From the Customers Table, select First Name and Last Name. Click Next. 

Leave on Detail. Click Next. 

Leave the title as Trips Query and then Click Finish. 
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Now we’re going to run a report based on our first query. You may have to 
save your query before you can create a report. 

Report 1: Trip Roster 

Go to the Create Tab  Reports Group  Reports Wizard 

Make sure that the query 
we just created, Query: 
Trips Query appears under 
Tables/Queries. 

Select all fields under 
Available Fields by clicking 
the  button. 

 

 

 Click Next to view your data by Trips.  

 Click Next. Do not add any grouping levels. 

 Click Next. We are going to sort by Last Name in ascending order. 

 Click Next. Leave the layout as it is.  

 Click Next. Choose the style labeled Module. 

 Click Next. We’re going to call this report Trip Roster. 

 Click Finish.  

We are going to have to make some minor adjustments in Layout View so that 
we can read the Destination names. Go to Layout View and see if you can fix 
the problem. HINT: see pages 10-11. 

Query 2:Trips Unpaid -  We want to find out which customers still need to pay 
for their trip(s).  

This time, we are going to create a query in a different way. Go to Create  
Other Group  Query Design 
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Select all of the tables by clicking 

Customers, holding down your 

Control (Ctrl) key and clicking the 

remaining two tables. 

Click Add. Then click Close. 

 

 

 

 

We’ll see a relationship map. To select fields for the query, simply double-click 
on the field name you want to add. Your query should look like the image 
below.  

We only want to see customers that still have not paid, so we are going to 
include a criteria “no” under Paid in Full. Uncheck the box under that field, too. 

 

Right-click on the Query1 tab to Save it. Name it Trips Unpaid. Then click Run! 
in the Design tab and the Results group. You’ll see a list of customers that still 
owe money. 



 
 
 

 
 

 

 
 

Public Computer Center, Version 1.1 Page 25 of 26 
* All instruction based on Windows 7 Operating System 

Report 2: Trips Unpaid 

Now we are going to run a report based on our second query. You may have to 
save the Trips Unpaid query before you can continue. 

Go to the Create Tab  Reports Group  Reports Wizard 

A dialogue box will appear. Make sure that the Trips Unpaid query has been 
selected under Tables/Queries. 

 Click the  button to add all of the fields from the Trips Unpaid query. 

 Click Next. Leave this section alone. It should be set to by Trips. 

 Click Next. We aren’t going to add any other grouping levels. 

 Click Next. We will sort by Last Name. 

 Click Next. We aren’t going to change the layout. 

 Click Next. Select a design. (Trek for instance.) 

 Click Next. Retitle the Report Trips Unpaid. Click Finish. 

 Adjust the layout in Layout View.  

 

Adding Counts in Reports 
You can tabulate how many people are going on the trip to New York City and 
how many are going on the trip to the Wineries, as well as the total of both 
trips combined.  

Go to the Design View of the Trips Unpaid report. Click on Last Name so that it 
is outlined in yellow. 

In the Design tab  Grouping & Totals 
group, click the drop-down arrow next to 
Totals. Then select, Count Records. 

When you switch to the Report View, you’ll 
see the totals listed. 
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Summary 
Hopefully at this point you have a good understanding of the basic features 
within an Access database and how to use them. We have added components, 
and are well on the way to creating a systematic method for storing data and 
creating reports and queries to run our business or organization more 
efficiently. In addition to the techniques we’ve learned in the last two classes, 
the capabilities of Access are quite complex. For more information on the 
capabilities of Access, visit the Microsoft Office site at support.microsoft.com. 


